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5	 Formatting
So far we have not worried about getting everything to look neat and attractive, so that is what we are 
going to do now.

Unless you simply want to make a little simple calculation for yourself, you should consider the formatting 
of the spreadsheet. If you need to make a large, complex spreadsheet that other people are going to use, 
you should be aware that, while the construction might appear logical to you, it can be difficult for others 
to understand the logic. Appropriate formatting also indicates quality and credibility.

There are a myriad of options for formatting in Excel.  You can change row and column sizes, font 
types and sizes, colours, number formats, etc. You can even format the cells so that they change colour 
depending on their value!

5.1	 Text and colours

You are free to format text and numbers in cells and give them colours. You can format multiple cells 
at once as long as you make sure they are selected first.

Many functions in Excel can be found in several ways. The main ways to find a function are by means 
of the Ribbon, “contextual menus” or shortcut keys.

5.1.1	 Formatting using the Ribbon

Most features for text formatting are located in the “Ribbon”. Let us practice a little.

1.	 Try typing your name in a cell.
2.	 Ensure the cell is active.

The Ribbon is organised into different Tabs.  You need the tab labelled “Home”, where you find the 
formatting functions. Please refer to Figure 28.

Figure 28: Text formatting in the Ribbon.
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The buttons in the Ribbon are divided into groups. The group where we find the most important buttons 
is “Font” group. 

3.	 Click on the button . The text will likely become red.

Figure 29: There are many colours to choose between.

If you have played around with it previously, the text may get a different color, since there are several 
possibilities. This button has a little arrow on the right side giving access to more options. 

4.	 Try clicking on the small arrow on the button.
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This gives you the opportunity to choose between several colours. Click on one of the blue hues. Your 
text is now blue.

You can also format multiple cells at once.

5.	 Highlight the cell with your name plus some more cells.
6.	 Click on the button in the Ribbon. Now you have a yellow background. Just as with the text, 

you could also have chosen a different colour.
7.	  If you are still not satisfied, you can click on More Colours, and choose from up to 16 

million different colours. That should be enough for most people!
8.	 Click the little arrow on the right button. This button is what we call the “Font 

Changer”. Your font changer might display another font than “Calibri”, but you do not risk 
ruining anything by clicking on it anyway!

9.	 You are about to select another font, so try, for example “Arial Black”.
10.	 To the right of the font changer there is a button where you select the font size. Try for 

example 24. That will make the text much larger.

Try some of the other buttons to discover their effect.

5.1.2	 Formatting using the shortcut menu

Modern Windows programs rely largely on the shortcut menus that pop up when you click on something 
with your right mouse button. In the shortcut menu you find the most frequently used functions related 
to what you have just clicked on. 

1.	 Type you name in a cell and press ENTER.
2.	 Click on the cell with the right mouse button to display the “shortcut menu”.

Figure 30: A right-click with the mouse makes the shortcut menu appear.
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At the top of the shortcut menu, you will find buttons that resemble those in the Ribbon; they also work 
just the same way. But we must try some new features.

3.	 Click on the menu item Format Cells

This will give you access to all the options available to format one or more cells. A dialog box opens, 
and you can choose between different Tabs at the top.

4.	 Select the Font, Tab and the following window appears:

Figure 31: Here you can set the font.

5.	 Select the font size and color that suits you, then click the Fill Tab.

You can choose to fill the cell with a fill colour, a pattern or a colour effect. We have already tried a 
normal fill colour, so let us try something with effects! 

6.	 Click on the Effects button and a new window will open.
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Figure 32: Effect colour.

In Excel the effect colours consist of two colours which gradually blend into each other.

7.	 Try choosing colours by clicking on Colour 1 and Colour 2.
8.	 Try clicking on the different Shading Types. When you are satisfied, click OK.
9.	 Click OK again.
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My little experiment turned out thus:

Figure 33: My own experiment.

5.1.3	 Borders and Frames

When you look at a blank worksheet, there are some thin lines that indicate where the cells are. Without 
these lines it would be harder to identify a particular cell in the sheet. But these “grid lines” are only 
auxiliary lines; they are not written out unless you specifically request it, and if you provide some cells 
with a fill colour, grid lines will not be displayed in that area.

But you can add borders and frames yourself, and you can even choose the colour and how thick they 
should be.

1.	 Select cell region B2:E5.
2.	 Click with the right mouse button inside the area and select Format Cells.
3.	 Select the Border Tab in the dialog box that appears.

Now we need to make some grid lines. We would like to have a thick border around the selected area 
and some thin grid lines that show the cells inside the area. It is actually very easy to do, but it is quite 
difficult to explain because you must click in many different places in the correct order.

I have therefore made the following illustration that shows what you need to click and in what order.

Figure 34: The approach used to make grid lines and frames in the selected area.
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The window is divided into three groups of objects you can click on. The first group is “Line” where you 
choose how your edges should look and what colour they should have. The next group is the “Presets”, 
where you can choose between None, Contour and Interior.

The function None is relevant if you have already made some lines that you want removed. The Contour 
function makes a frame around the selected cell region with the line you have chosen. The Interior 
function draws lines inside the selected cell regions, which highlights the individual cell.

The final group in the dialog box is “Border”, where you can do exactly the same thing as in the group 
“Presets”. The difference is that here you can control exactly which lines you want. For example, you can 
settle for a thick line at the top and bottom of the marked area or you can choose to have only horizontal 
interior lines. Let us see how it works. We will follow the numbering in Figure 38.

1.	 First, click the thick line.
2.	 Choose a colour.
3.	 Click on Contour.

You have now defined the frame around the selected area.

4.	 Click on the thin line.
5.	 Choose a colour as in point 2, but preferably a second colour for illustration
6.	 Click on the button for interior horizontal lines.

If you wish, you can choose another line type and colour before you proceed to point 7.

7.	 Click OK.

Your result hopefully looks like mine in Figure 35

Figure 35: Frame and gridlines have been added.

http://bookboon.com/


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2007

50 

Formatting

Now you should have a good insight into the possibilities for colouring your worksheet. Colours can have 
a large impact. If used right, they can make a complicated spreadsheet much more logical, simple and 
inviting. I use formatting for larger spreadsheets, although I may be the only one who needs them. For 
example, I almost always colour cells with formulas, while I keep cells without formulas white. In this 
way I can quickly see which numbers are the ones being entered and which are the calculated values.

5.2	 Number Formats

We will now leave the department of colours and stripes and return to numbers. Numbers can be displayed 
in many ways. Which of the following numbers do you think is most readable?

1000000
or
1.000.000

If the figure referred to money, one million could also be written as “kr 1,000,000.00. In other cases you 
might be interested in controlling how many decimal places to display. This you also control via formatting.

1.	 Type the figure 123456 in cell B2.
2.	 Click with the right mouse button on the cell and choose Format Cells.
3.	 Click on the Number Tab if it has not been selected already.
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Now we can choose between a lot of different number formats. In the pane “Category” you can choose 
between the basic types, and depending on what you choose, different options will appear. Try clicking 
on the different types, so you get an idea of the possibilities before we proceed. Do not click OK. 

Click on the category Number, which will make the dialog box look like Figure 36.

Figure 36: Formatting numbers.

4.	 At Number Of Decimal Places, choose “1”.
5.	 Put a check mark by Use Thousands Separator. This means that periods are inserted in the 

number, like the example with 1.000.000 instead of 1000000.
6.	 Click OK.

Figure 37: The number has been formatted.

Now your number looks like Figure 37.  The figure remains the same, but it appears in a different 
way. Please note that, although only one decimal place is displayed, all decimals are still counted. You 
will see that if you look at the formula bar when the cell is selected. Number formats have no bearing 
on the cell value.
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7.	 Type 25% in cell B4 and press ENTER.

In this case Excel assists a little with the number format because it actually displays “25%”. What you 
are not able to see is that the cell’s value is actually 0.25. You can discover that by changing the number 
format to a number with two decimal places. If you wish, you can try it.

Figure 38: By changing the number format it is shown that 25% is the same as 0.25.

5.3	 Date and Time

You can write the date and/or time in several ways. When you type a date and/or time, Excel automatically 
formats the cell to an appropriate date or time format. All you have to do is type it in correctly. Dates 
will be recognised if you write them in one of the following ways: 

25-3-2008

or
25/3/2008

Times will be recognised if you write them in one of the following ways:

17:45 (hours:minutes)
17:45:30 (hours:minutes:seconds).

Date and time can of course also be combined by putting spaces in between, for example:

25-03-2008 17:45:30
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You can perform calculations with dates and times. Excel uses a clever numbering system to keep track 
of dates and times.

When there is a date and/or time in a cell, the cell just has a numerical value that is formatted as date/
time. This could lead to headaches if it were to be used in a calculation, but it is pretty simple.

Excel’s calendar begins on January 1 1900, 00.00.  This time point has the value “1”.  January 2 1900, 
00:00, has the value “2”.

In other words, For each day 1 is added. The time is also part of this system, so January 2 1900 at 12.00 
noon, has the value “2.5”. One hour thus corresponds to 1/24, or 0.041666667 to be precise. Actually, 
Excel operates with 10 decimal places, so you can calculate with very accurate time points.

5.4	 Formatting Tables

When working with a spreadsheet, one usually makes tables. Once you have made a table where you have 
inserted sum formulas, etc., Excel can format the table automatically, so it looks neat and presentable. 
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Figure 39: Create a table like this. 

1.	 Create a table like the one in Figure 39. 
2.	 Ensure that one of the cells in the table is the active one.
3.	 In the Ribbon, make sure that the “Home” Tab has been selected. Then Click on the Format 

As Table button in the Ribbon. 

4.	 A menu will pop up and you can choose a table layout
5.	 A small box will appear and ask what region you wish to define as the table. It is usually 

right on target if you have done as I have shown.
6.	 Finally you must also make sure to put a marker in the My Table Has Headers box, which 

ensures that the column headers are highlighted. 
7.	 Click OK.

Now your table should have been formatted with the highlighted title and everything. You can still change 
the formatting of individual cells if you like. My table came to look like this: 

Figure 40: My table looks like this. 

But formatting of the table is not the only thing that has happened. In addition to formatting the table, 
the Ribbon at the top has changed, and you now see a range of functions that relate to the tables. A Tab 
has been added in the Ribbon, which is available when you activate a cell in the table. 

That is because the tables in Excel are not only about the formatting. There are some special options 
when you define specific areas of a worksheet as tables, which we will return to later in the book.
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Figure 41: The Ribbon changes when you format a table.

But it is not the only thing that has happened; some arrows have appeared beside the column headers. These 
arrows can be used as “filters”, where you can select specific data that you want to see. It has no relevance 
to a table like the one we just created, but if you work with a table with many data covering hundreds 
of lines it can be very practical. If you print the worksheet, the arrows do not show on the printout, but 
you can also remove the arrows by disabling the filter. To disable the filter, do as follows:

1.	 Select the Data Tab in the Ribbon.
2.	 Click on the Filter button. It is easy to find because at present the filter is active, which 

means the button is highlighted with a red/orange colour.

Figure 42: Excel is being “creative” by inserting column headers.

Now the arrows have disappeared from the column headers, but there has also been another change 
in the table. In the upper left corner it suddenly says “column1”. I wondered the first time I saw this in 
Excel 2007, since I had never seen it before.

The explanation is that when you define a field as a table Excel requires that all columns have a header. This 
is because Excel will use the headlines in connection with the sorting and filtering features that are 
available for tables. This is also the reason you cannot delete the text.

You can write anything you want, but Excel does not allow this cell to be empty.

I you want it to be empty anyway, I have a little “trick” for you.

1.	 Activate the cell.
2.	 Press the spacebar on the keyboard.
3.	 Press the ENTER key on your keyboard 

Now you have typed an empty space in the cell, and spaces are invisible. 
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5.5	 Conditional Formatting

Excel can change the colour, font, etc. of a cell, depending on what value it has. You can pre-select a 
number format that shows negative numbers in red, but conditional formatting gives more options.

The way it works is that you give a cell the format you would like it to have as a starting point. Then 
you set up a list of the alternative formats it can have, and what conditions must be met for it to change 
the format.

Imagine an example where you want to build up statistics on absenteeism rates among a group of 
employees. You make a list of employees and a calculation of absence rates.

If the absence rate for the individual employee is less than 5%, the cell should have default formatting. If 
absence rates are greater than 5% but less than 8%, the cell should be marked with a yellow background 
colour. If the absenteeism rate is 8% or more, the cell should have white writing on a red background 
colour. 

If you have worked with conditional formatting in earlier versions of Excel, this may not be new to you. But 
Excel 2007 has introduced a new way to define rules.  It has now become much easier.  In addition, it 
has become possible to use a value-dependent colour spectrum, which can give quite impressive results. 
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Figure 43: Starting point for the exercise with conditioned formatting

Let us try a couple of exercises.

1.	 Create a spreadsheet as in Figure 43.
2.	 Select the cell region B2: E6. The selected cells will be included in the conditional 

formatting.
3.	 Ensure that the “Home” Tab has been selected in the Ribbon and click the Conditioned 

Formatting button. 
4.	 In the menu that appears, point to “Top/Bottom Rules” to make a submenu appear.
5.	 Click on Top 10%. This means that those 10% of the cells that have the highest values will 

be highlighted. 

You will now have the opportunity to fine-tune the formatting. A dialog box will appear where you can 
change the rate distribution. For example, you might want to highlight the cells with the top 20% values.

You also have the opportunity to choose between several predefined formattings by clicking on the list 
in the dialog box.  If you select Custom Format on the list, you can fine-tune the format and choose 
exactly what colours you want.

6.	 Select Light Red Fill With Dark Red Text.
7.	 Click OK.
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Now the cells with the two highest values should be selected. In my case it looks like this:

 Figure 44: Conditioned formatting where the top 20% values have been highlighted

Figure 45: The Formatting changes if you change the values.

8.	 Try typing the number 21 in the cell with the value 7.

This will make the highlight disappear from the cell with the value 19, because now the cells with the 
values 20 and 21 constitute the top 10%.

9.	 Select all the cells again.
10.	 Select the Conditioned Formatting button again.
11.	 Point to Highlight Cell Rules to make a submenu appear.
12.	 Click on Between, which gives us the opportunity to highlight cells with values within a 

certain range.
13.	 In the dialog box that appears, write 15 in the first field and 20 in the second field.
14.	 Choose the format Yellow Fill With Dark Yellow Text.
15.	 Click OK.

If you have followed my instructions to the letter, your spreadsheet now looks like this:
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Now you have two different conditional formatting that work in the same cells. First, the top 10% of cells 
are coloured pink, and then the cells with values between 15 and 20 are coloured yellow. The conditions 
operate in the order you created them. It was the yellow formatting that was created last, therefore the 
cell with the value 20 is also yellow, although it was previously pink.

16.	 Ensure the cell region we have been working with so far is selected.
17.	 Click on the Conditioned Formatting button again.
18.	 Choose the menu item Administer Rules in the menu that appears.

Figure 46: Rule management for conditioned formatting
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You now have the ability to manage the order of the rules you have set up for conditional formatting. You 
can also add, delete or modify rules. In this exercise we just need to reverse the order.

19.	Ensure that the rule for Cell Value between 15 and 20 has been chosen.

20.	Click on the Move Down button. It looks like this: .
21.	Click OK.

Now your spreadsheet looks like this:

Figure 47: Now the cell med the value “20” has become pink again.

Now the rule is applied to highlight the top 10% values last, so cell E6 has become pink again.

There are many other possibilities for conditional formatting. It is, for example, possible to give the cell 
a hue from pale yellow to deep red, depending on how high the value is. Many of these options arguably 
belong to the “extra icing on the cake” category, but they can also be used to make the spreadsheet more 
readable.

5.6	 Themes and Styles

Themes and Styles is a new option in Excel 2007, but you probably recognise Styles from Word and 
PowerPoint, where they have been used in many earlier versions.

Use of Themes and Styles helps you make “nice” worksheets where you can easily create a uniform and 
neat appearance. As you might have noticed by now, I like to emphasise that the spreadsheet should do 
more than just calculate correctly. If you are building large and complicated spreadsheets to be used by 
anyone other than yourself, it is important that it is logical and clearly structured, and preferably nice 
to look at. When it is neat and easy to understand, there will not be so many mistakes. It will also make 
it more credible. 

If you got good grades for your arithmetic homework in school, you probably know what I mean. If you 
did not get good grades, it might be a consolation that Excel now can assist you.
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Themes can be regarded as an overarching set of guidelines for the fonts and colour combinations you can 
use in your spreadsheet. You can even define your own Themes, but Excel comes with many predefined 
Themes where the colours already match nicely. A Theme defines for example that all header cells must 
have green background colour and be written in bold type, while cells with formulas should be bright 
green. If you change the Theme for the entire worksheet, the changes will be reflected in all the cells to 
which you have assigned a “Style”.

A style is something you assign to each cell. You can for example define that cell B2, C2 and D2 are 
headings in a table, while the cells below are general number-cells.  At the bottom you might have 
calculated a sum, in which case you can give the lower cells the style “Calculation”.

Let us see how it works.

1.	 Start with a blank spreadsheet and create a table as shown in Figure 48. The table does not 
really make sense and is only meant as an example.

Figure 48: The starting point for the exercise.

We start by assigning a “theme” to the spreadsheet. This theme will affect our subsequent formatting of 
the spreadsheet.

2.	 Choose the Page Layout Tab in the Ribbon and click on the button furthest to the left, 
called Themes (Figure 49).

3.	 A menu will appear where you can choose between various different themes. Click on the 
Sequence theme.
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Figure 49: Choosing theme.

At the moment there are few visible changes in the spreadsheet. Only the font in the cells has changed.
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4.	 Select the cell region C2:E2.
5.	 Choose Home Tab in the Ribbon and click on the Cell Styles button. 

 Figure 50: Choosing Cell Style.

When you click the Cell Style button, a menu will appear where you can choose from a variety of named 
Styles. When you point to the individual Styles with your mouse, you can see how it will look in your table.

6.	 Click on the Style Heading 1.
7.	 Select cell region B3:B8.
8.	 Click the Cell Styles button and choose the style Accent1.
9.	 Select cell region C8:E8.

10.	 Click on the Cell Style button and choose the Calculation Style.
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If you have done as I, your spreadsheet will look like this:

Figure 51: Table with Styles.

Now we will try some other colours, but we do not want to format the individual cells again so we will 
choose a different colour theme.

Select the Page Layout Tab in the Ribbon, then click the Themes button Search. Click on the theme 
Sumptuous (anything less will not do!). 

Now your spreadsheet looks like this:

Figure 52: Spreadsheet wtth the the “Sumptuous”. 

Now you have been introduced to Themes and Styles, and you can now experiment with them on your 
own.

If you continue working with Themes and Styles, you may also find that when you insert charts, graphs 
etc., they will also have colours defined in the colour theme you have chosen, and so it all fits together.
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